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Abstrak 

Penelitan ini bertujuan untuk 1) Membuat model pemetaan tingkat kerawanan kebakarn hutan dan 

lahan 2) Mengetahui tingkat kerawanan kebakaran hutan dan lahan. Metode yang digunakan dalam 

penelitian ini adalah analisis data sekunder. Data yang digunakan adalah data DEM untuk 

kemiringan lereng dan sungai, data jenis tanah dan data penggunaan lahan. Teknik pengumpul 

data 1) Analisis Data Penginderaan Jauh (PJ) adalah cara untuk mendapatkan informasi suatu 

objek, wilayah atau fenomena melalui analisis data yang diperoleh dari sensor pengamatan tanpa 

kontak langsng dengan objek, wilayah atau fenomena yang diamati. 2) Tracking adalah cara 

pengumpulan data dalam periode tertentu dengan tujuan pemantauan atau pengamatan perubahan, 

seperti kemiringan lereng, jenis tanah, sungai, penggunaan lahan. Parameter data kemiringan 

lereng, jenis tanah, jarak sungai, pengunaan lahan sebagai parameter untuk analisis sistem 

informasi geografi agar mendapatkan peta tingkat kerawanan kebakaran hutan dan lahan. 

Parameter ini diolah dengan memamfaatkan aplikasi arcgis 10.8 yang di gunakan untuk mengolah 

serta memproses data tersebut menjadi sebuah peta. 

 

Kata Kunci: Pemetaan, SIG, Karhutla. 

Abstract 

Research this aim to 1) Create a mapping model level vulnerability on fire forest and land 2) 

Knowing level vulnerability fire forest and land. Method used in study this is secondary data 

analysis. Data used is the DEM data for tilt slope and river, data type soil and usage data land. 

Technique data collector 1) Sensing Data Analysis Far (PJ) is method for get information 

something object, region or phenomenon through analysis of the data obtained from the 

observation sensor without contact direct with object, region or observed phenomenon. 2) 

Tracking is method data collection in period certain with destination monitoring or observation 

changes, such as tilt slope, type land, river, use land. Slope data parameters slope, type ground, 

distance river, use land as a parameter for analysis system information geography to get map level 

vulnerability fire forest and land. These parameters processed with take advantage of application 

arcgis 10.8 in use for process as well as process the data becomes a map. 

 

Keywords: Mapping, GIS, forest and land fires. 

 

PENDAHULUAN 

 Indonesia sering terjadi bencana 

kebakaran hutan dan lahan. Kebakaran hutan 

dan lahan diakibatkan mulai dari peningkatan 

CO2 (Karbon Dioksida) dan suhu. 

Peningkatan suhu diakibatkan oleh fenomena 

El Nino yang telah terjadi sehingga 

menimbulkan dampak yang lebih besar 

terhadap lahan kering ataupun kondisi 

pemicu kebaran hutan di Indonesia. 
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Perubahan iklim global yang terjadi 

berdampak terhadap musim kemarau yang 

berkepanjangan sehingga rentan terhadap 

terjadinya kebakaran hutan dan lahan 

(Viviyanti et al., 2019). 

 Masalah non teknis juga ikut 

berpengaruh seperti soal koordinasi antar 

instansi yang tidak maksimal dan sikap 

mental sebagian pihak yang tidak 

berkomitmen pada kelestarian lingkungan. 

Begitu juga soal kebijakan yang tidak tegas 

dan jelas dalam perlindungan kawasan 

resapan air, termasuk pula upaya penegakan 

hukum yang kerap kurang berimbang dan 

kurang konsisten (Wibowo, 2019). Dalam 

laporan tahunan WorldLife Fund, sebuah 

Lembaga Swadaya Masyarakat (LSM) yang 

fokus pada isu lingkungan menyatakan 

bahwa Hutan Kalimantan diyakini akan 

menyusut hingga 75 persen pada tahun 2020 

jika laju deforestasi tidak dihentikan. Dari 

sekitar 74 juta hektar hutan yang dimiliki 

Kalimantan, hanya tersisa 71% pada tahun 

2005. Sedangkan jumlah pada tahun 2015 

menyusut menjadi 55%. Jika laju deforestasi 

tidak berubah, Kalimantan diyakini 

kehilangan 6 juta hektar hutan pada tahun 

2020, artinya hanya tersisa kurang dari 

sepertiga kawasan hutan (Terbuka et al., 

2019). 

 Kebakaran hutan dan lahan 

merupakan salah satu bentuk gangguan yang 

semakin sering terjadi. Dampak negatif yang 

ditimbulkan oleh kebakaran hutan cukup 

besar mencakup kerusakan ekologis, 

menurunnya keanekaragaman hayati, 

merosotnya nilai ekonomi hutan dan 

produktifitas tanah, perubahan iklim mikro 

maupun global, dan asapnya mengganggu 

transportasi baik darat, laut dan udara. 

Mengingat dampak kebakaran hutan tersebut, 

maka upaya perlindungan terhadap kawasan 

hutan sangatlah penting. Untuk mencegah 

terjadinya kebakaran hutan dan lahan perlu 

adanya suatu peta yang menyatakan daerah 

yang rawan terhadap kebakaran hutan dan 

lahan dengan pertimbangan aspek penutupan 

lahan, jenis tanah, curah hujan, ketinggian 

tempat dan jarak pemukiman (Putra et al., 

2018). 

 Upaya pengendalian kebakaran hutan 

dan gambut yang sering dilakukan adalah 

kegiatan pemadaman kebakaran hutan yang 

terjadi. Pemadaman kebakaran hutan dan 

gambut dilakukan secara terintegrasi dengan 

Manggala Agni dari Departemen Kehutanan 

dibantu instansi lainnya dan masyarakat. 

Namun upaya tersebut kadangkala tidak 

optimal hasilnya terutama di lahan gambut. 

Pengendalian kebakaran hutan dan gambut 

akan efektif apabila diketahui faktor-faktor 

yang mempengaruhi luas kebakaran hutan 

dan gambut (Cahyono et al., 2015). Namun, 

hutan sensitif terhadap variasi iklim yaitu, 

peningkatan suhu dan penurunan curah hujan 

yang menyebabkan kekeringan, dan variasi 

ini membuat hutan lebih rentan terhadap 

kebakaran (Bui et al., 2016). Bencana 

didefinisikan dalam Undang-Undang 

Republik Indonesia Nomor 24 Tahun 2007 

adalah peristiwa atau rangkaian peristiwa 

yang mengancam dan mengganggu 

kehidupan dan penghidupan masyarakat 

yang disebabkan, baik oleh faktor alam dan 

faktor nonalam maupun faktor manusia 

sehingga mengakibatkan timbulnya korban 

jiwa manusia, kerusakan lingkungan, 

kerugian harta benda dan dampak psikologis 

(Azkia, 2020). 

 Sejarah kebakaran hutan dan lahan 

dapat dijadikan suatu pelajaran penting, 

terutama apabila sejarah tersebut dikaji 

secara lengkap. Sejarah kejadian dapat 

dijadikan dasar analisa pola dan perilaku 

yang menjadi dasar pemikiran untuk 

melakukan upaya pencegahan di masa 

mendatang. Yang sering menjadi kelemahan 

kita adalah seringkali dokumen-dokumen 

yang berisikan informasi, catatan penting dan 

ataupun sederhana (yang pada saat ini tidak 
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kita anggap penting) tidak terdokumentasi 

dengan baik (Pusdiklat Lingkungan Hidup et 

al., 2014). Ketika faktor-faktor seperti 

kelembaban rendah, angin kencang, 

topografi dan arah angin menguntungkan, 

kebakaran dapat berkembang dengan cepat 

jika jumlah dan ketersediaan bahan bakar 

sesuai (Van Hoang et al., 2020). 

Karbondioksida yang sangat berbahaya bagi 

masa depan generasi. Bicara soal kebakaran 

hutan dan gambut, maka Riau adalah 

laboratorium yang paling pas untuk melihat 

bagaimana regulasi dan implementasi di 

lapangan berakibat fatal selama berdekade. 

Tanpa menyebut kejadian terparah tahun 

1997 lalu (Wahyu Purwanto, David M 

Haryanto, 2015). 

Kebakaran merupakan kejadian yang 

muncul dari adanya api yang tidak terkontrol 

yang disebabkan oleh konsleting listrik, 

rokok, dan bahan kimia. Pedoman Segitiga 

Api menjelaskan tentang munculnya api 

memerlukan 3 komponen yakni bahan yang 

mudah terbakar, oksigen dan panas. 

Kebakaran bisa terjadi dimana dan kapan saja 

ketika ada bahan yang mudah terbakar dan 

sumber kebakaran (Ii & Kebakaran, n.d.). 

Kebakaran merupakan salah satu peristiwa 

yang tidak diinginkan dan terkadang tak 

terkendali. Maraknya kebakaran hutan dan 

lahan di Kalimantan Barat pada musim 

kemarau yang sering terjadi pada bulan Juli, 

Agustus, dan September menyebabkan 

berkurangnya luas wilayah hutan. Secara 

umum ada dua faktor penyebab kebakaran 

hutan dan lahan di Kalimantan Barat. Faktor 

pertama adalah kelalaian manusia yang 

melakukan aktivitas didalam hutan. Kedua, 

adanya faktor kesengajaan yaitu membakar 

hutan. Saat pembukaan lahan baru dilakukan 

dengan cara membakar baik oleh masyarakat 

lokal maupun pengelolaan Hutan Tanaman 

Industri (HTI) akan menyebabkan semakin 

meningkatnya kebakaran hutan di 

Kalimantan Barat. Pada tahun 2019 

berdasarkan data Kementerian Lingkungan 

Hidup dan Kehutanan RI kebakaran hutan 

dan lahan diprovinsi Kalimantan Barat seluas 

151.919 hektar. Tidak ada hujan berturut-

turut selama seminggu dapat memicu 

kejadian kebakaran lahan dan hutan di 

Indonesia. Kayu atau ranting akan kering dan 

kemudian orang dengan mudahnya 

membakar, hal yang sama juga terjadi di 

lahan gambut (Anastasia et al., 2021). 

Kebakaran terjadi karena api kecil 

yang tidak segera dipadamkan. Untuk 

menimbulkan api harus ada 3 unsur yang 

saling berhubungan, yaitu oksigen, bahan 

yang dapat terbakar (bahan bakar), dan 

peningkatan suhu. Ketiga unsur tersebut 

disebut dengan istilah Segitiga api. Jika 

ketiga unsur tersebut masih ada maka 

kebakaran tidak akan padam. Setiap tahun 

kebakaran hutan terjadi di Indonesia. 

Kebakaran hutan yang sering terjadi sebagian 

besar diakibatkan oleh faktor kelalaian 

ataupun kesengajaan manusia dalam rangka 

pembukaan lahan secara besar besaran yang 

dilakukan oleh perusahaan perkebunan dan 

kehutanan secara ilegal, baik untuk usaha 

pertanian, kehutanan maupun perkebunan 

dan hanya sebagian kecil saja yang 

disebabkan oleh alam (petir). Kebakaran 

hutan terjadi akibat adanya pembersihan 

lahan (land clearing) dan konservasi hutan 

menjadi perkebunan dengan cara membakar 

serasah, daun dan sisa tumbuhan. Metode 

pembakaran ini merupakan metode yang 

paling murah, mudah dan efisien. Namun 

akibat tidak terkendalinya pembakaran 

tersebut, api merambat kemana-mana dan 

menimbulkan kebakaran (Siti, 2010). 

Kebakaran hutan yang terjadi di 

Kabupaten Kapuas Hulu merupakan kejadian 

bencana tahunan yang mampu merusak dan 

mempengaruhi ekosistem di kawasan hutan 

tersebut serta sangat mengganggu kesehatan 

dari masyarakat setempat dan aktivitas 

transportasi. Sehingga pencegahan sejak 

awal perlu dilakukan dalam penangan 

kebakaran hutan Kapuas Hulu. Dimana 
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dalam aplikasinya dapat menggunakan 

teknologi penginderaan jauh dan Sistem 

Informasi Geografis (SIG). Dengan teknologi 

ini kebakaran hutan dapat dicegah dengan 

pembuatan Peta Rawan Kebakara Hutan. 

Dimana untuk teknologi penginderaan jauh 

dapat dimanfaatkan dalam pemantauan 

perubahan penutup lahan di kawasan hutan 

yang menjadi sumber dari terbentuknya 

bahan bakar (Rafidah et al., 2014). 

Pemanfaatan teknologi SIG dalam 

pembuatan peta rawan kebakaran hutan 

merupakan hasil dari proses analisis spasial 

yang tersusun dari peta bahaya kebakaran 

hutan dan peta pemicu kebakaran hutan. Peta 

bahaya kebakaran didasarkan pada data 

cuaca, kondisi geografis, dan jenis vegetasi, 

sehingga lebih berhubungan dengan kondisi 

mudahnya terjadi kebakaran. Sedangkan peta 

pemicu kebakaran merupakan peta interaksi 

sosial dari budaya manusia terhadap alam 

(lingkungannya) yang berkemungkinan 

dapat menimbulkan api akibat dari interaksi 

manusia tersebut. 

Di samping teknologi SIG dan 

penginderaan jarah jauh, saat ini penerapan 

teknik-teknik data mining dalam pemodelan 

resiko kebakaran hutan mulai berkembang 

khususnya ketika pemodelan tersebut 

melibatkan banyak faktor dan data berukuran 

besar. Data mining merupakan proses 

ekstraksi informasi yang berguna dalam data 

ukuran besar. Teknik-teknik klasifikasi, 

clustering dan aturan asostasi dalam data 

mining diaplikasikan dalam data kebakaran 

hutan untuk mencari pola-pola menarik 

mengenai keterkaitan faktor menentu 

terjadinya kebakaran hutan yang berguna 

dalam pengambilan keputusan terkait 

pencegahan kebakaran hutan (Viviyanti et 

al., 2019). Definisi SIG selalu bertembah, 

berkurang, dan bervariasi. Hal ini karena SIG 

merupakan suatu bidang kajian ilmu dan 

teknologi yang relatif baru namun terlepas 

dari bervariasinya definisi SIG secara umum 

yang paling perlu diperhatikan adalah 

komponen-komponen yang disebutkan. 

Komponen Utama Sistem Informasi 

Geografis (SIG). Melihat SIG sebagai suatu 

sistem, maka SIG terdiri dari beberapa 

komponen-komponen penyusun. Komponen 

penyusun dalam SIG adalah: perangkat keras 

(hardware), perangkat lunak (software), 

organisasi (manajemen) dan pemakai (users). 

Kombinasi dari komponen-komponen 

tersebutlah yang akan menentukan 

kesuksesan pengembangan Sistem Informasi 

Geografis (Akossi, 2014). 

Analisis kebakaran hutan dan lahan 

dengan memanfaatkan teknologi 

Penginderaan Jauh dan Sistem Informasi 

Geografis masih tergolong baru dan belum 

banyak dilakukan. Padahal sesuai dengan 

perkembangan teknologi pemetaan 

Penginderaan Jauh dan Sistem Informasi 

Geografis memberikan suatu kemudahan dan 

keakurasian dalam menyajikan informasi 

geospasial untuk bidang kebencanaan 

khususnya kebakaran. Pemodelan spasial 

dengan mempertimbangkan parameter curah 

hujan, jenis tanah dan penggunaan lahan 

untuk mengetahui ancaman bahaya 

kebakaran menjadi suatu penelitian yang 

sangat penting dilakukan mengingat 

kebermanfaatannya untuk masyarakat secara 

luas (Viviyanti et al., 2019). Penyebab 

kebakaran di kabupaten kapuas hulu ada dua 

yaitu secara sengaja maupun karena alam 

tetapi penyebab yang sering terjadi yaitu 

karena kesengajaan ataupun manusia sendiri. 

Salah satu penyebabnya karena pembukaan 

lahan untuk pertanian penyebabnya karena 

masih menggunakan cara tradisional atau 

dengan cara dibakar serta masih terbatasnya 

sarana dan prasarana untuk memadamkan api 

pada saat melakukan pembakaran lahan 

pertanian hanya menggunakan alat seadanya 

yaitu semprot dan di bersihkan pinggiran-

pinggiran pertanian dengan maksud agar api 

tidak keluar dari lokasi yang telah di 

bersihkan ditambah lagi dengan isu oknum 

perusahaan yang berada disekitar lokasi 



Vol.2 No.2 Agustus 2022 Geo Khatulistiwa: Jurnal Pendidikan Geografi dan Pariwisata   ISSN:2808-2974 
 

34 
 

kebakaran pada lima tahun terakhir ini. 

Padahal pada saat belum terlalu banyak 

perusahaan di kabupaten kapuas hulu tidak 

sering terjadi kebakaran pada musim 

kemarau padahal masyarakat masih 

melakukan melakukan pertanian dengan cara 

tradisional dan dengan alat yang seadanya. 

Kebakaran Hutan dan Lahan di 

kabupaten Kapuas Hulu sangat sering terjadi 

baik itu secara sengaja maupun tidak sengaja. 

Di Kabupaten Kapuas Hulu sangat mudah 

sekali terjadinya kebakaran baik itu 

kebakaran hutan maupun kebakaran lahan 

penyebab nya adalah kemarau atau 

rendahnya intesitas curah hujan. Setidaknya 

ada satu titik kebakaran hutan maupun lahan 

yang terjadi di kabupaten kapuas hulu jika 

sudah terjadinya kemarau dan kemaraunya 

pun belum terlalu lama hanya kisaran dua 

minggu sampai empat minggu atau satu 

bulan pasti sudah ada kebakaran walaupun 

tidak di semua kecamatan. Dan lokasi 

kebakaran nyapun berbeda-beda pada setiap 

musim kemarau tergantung intesitas curah 

hujannya lagi. 

Agar dengan adanya peta tingkat 

kerawanan kebakaran hutan dan lahan 

masyarakat Kapuas Hulu khusus nya dapat 

mengetahui di daerah mana saja yang 

perpotensi dapat terjadinya kebakaran hutan 

dan lahan. Dengan ini kalau masyrakat tau 

daerah mana saja yang mudah terjadi 

kebakaran pasti masyrakat akan berhati-hati 

pada saat berada di daerah tersebut. 

 

METODE PENELITIAN 

Metode yang digunakan dalam 

penelitian ini adalah Analisis Data Sekunder. 

Data yang diambil adalah kemiringan lereng, 

sungai, jenis tanah dan penggunaan lahan. 

Adapun metodologi secara keseluruhan 

adalah sebagai berikut : 

Teknik Pengumpul Data 

a. Analisis Data PJ 

Analisis Data Penginderaan Jauh 

(PJ) adalah cara untuk mendapatkan 

informasi suatu objek, wilayah atau 

fenomena melalui analisis data yang 

diperoleh dari sensor pengamatan tanpa 

kontak langsng dengan objek, wilayah 

atau fenomena yang diamati. 

b. Tracking 

Tracking adalah cara 

pengumpulan data dalam periode tertentu 

dengan tujuan pemantauan atau 

pengamatan perubahan, kemiringan 

lereng, jenis tanah, sungai, penggunaan 

lahan. 

Prosedur Analisa Data 

a. Pengambilan Data 

Data kemiringan lereng dan 

sungai diambil dari DEM, data jenis 

tanah diambil dari Ina Geospasial, 

dan data penggunaan lahan diambil 

dari Land Use Land Cover (LULC). 

b. Model Builder 

Mengomatiskan sejumlah 

urutan proses rutin mengenai 

pembuatan data spasial agar 

kemudian dapat diulangi secara 

presesi kapan saja dan oleh siapa daja 

tanpa kesalahan yang berarti. 

c. Score Tingkat Kerawanan Kebakaran 

Hutan Dan lahan 

1. Kemiringan Lereng 

Tabel 1. Klasifikasi Kemiringan 

Lereng 

Score Kemiringan (%) Klasifikasi 

1 0 – 8 % Datar 

2 8 – 15 % Rendah 

3 15 – 25 % Sedang 

4 25 – 45 % Tinggi 

5 ≤ 45 % Curam 

 

2. Jenis Tanah 

Tabel 2.  Klasifikasi Jenis Tanah 

Score Klasifikasi  

0 

1 

Sangat Tidak Mudah 

Tidak Mudah 

2 Sedang 
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3 Mudah 

4 

5 

Sangat Mudah 

Tinggi 

3. Sungai 

Tabel 3. Klasifikasi Jarak Sungai 

Score Jarak Sugai (Km) 

1 0 - 2  

2 2 – 4  

3 

4 

5 

4 – 6  

6 – 8  

8 – 10  

4. Penggunaan Lahan 

Tabel 4. Klasifikasi Penggunaan 

Lahan 

Score Klasifikasi 

1 Sangat Tidak Mudah 

2 Tidak Mudah 

3 Sedang 

4 

5 

6 

Mudah 

Sangat Mudah 

Tinggi 

5. Tingkat Kerawanan Kebakaran 

Hutan Dan Lahan 

Tabel 5. Klasifikasi tingkat 

Kerawanan Kebaran Hutan dan Lahan 

Score Klasifikasi 

1 Sangat Tidak Mudah 

2 Tidak Mudah 

3 Sedang 

4 

5 

Mudah 

Sangat Mudah 

d. Weighted Zum/Pembobotan 

Parameter akan diberi bobot dan 

nilai skor sesuai dengan tingkat 

pengaruhnya. Pemberian skor dan bobot 

pada metode berjenjang tertimbang 

tersebut selanjutnya akan diteruskan 

dalam analisis spasial (Rafidah et al., 

2014). Proses Weighted Zum merupakan 

proses pembobotan pada parameter-

parameter yang telah dibuat. Proses 

Weighted Zum dilakukan untuk 

pembobotan pada parameter yang telah 

memiliki pengkelasan dengan melakukan 

proses classify. 

e. Pembuatan Peta Kerawanan 

Kebakaran Hutan Dan Lahan 

Pembuatan peta kerawanan 

kebakaran hutan dan lahan dengan 

menggunakan proses Weighted Sum. 

Weighted Sum berfungsi untuk 

menganalisis berbagai jenis parameter 

yang kemudian disatukan menjadi satu 

kesatuan yang dapat mewakili 

keseluruhan parameter. Pembobotan 

pada Weighted Sum dilakukan dengan 

membandingkan persentase tingkat 

potensi kerawanan antar berbagai 

parameter seperti yang terdapat pada 

tabel 6. 

Tabel 6. Parameter Pembobotan 

Weighted Zum 

Score Klasifikasi 

1 Sangat Tidak Mudah 

2 Tidak Mudah 

3 Sedang 

4 

5 

Mudah 

Sangat Mudah 

HASIL DAN PEMBAHASAN 

Hasil 

a. Model Pemetaan Tingkat Kerawanan 

Kebakaran Hutan Dan Lahan 

1. Kemiringan Lereng 

 
Gambar 1. Model Pemetaan 

Kemiringan Lereng 

1) Potong Dem dengan area 

pemotong, caranya masuk ke 

ArcToolbox, kemudian pilih 

Spatial Analyst Tools > 

Extraction > Extract By Mask. 
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Lalu tentukan raster yang akan di 

potong dan area pemotongnya. 

2) Ubah koordiant system DEM 

yang semula adalah WGS 1984 

menjadi koordinat system UTM, 

caranya masuk ke ArcToolbox, 

kemudian pilih Data Managemen 

Tool > Projection and 

Transformation > Raster > Raster 

Project. 

3) DEM yang sudah di potong 

apabila mengunakan data kontur 

tersebut harus di konversi terlebih 

dahulu menjadi format raster 

dengan cara masuk ke 

ArcToolbox, pilih 3D Analyst 

Tools > Raster Interpolation > 

Topo to Raster. 

Masih dalam Tools ini juga 

setting Enviromentts nya, bagian 

Processing Extent atur Snap 

Raster berdasarkan batas wilayah 

(Kabupaten) dan bagian Raster 

analysis atur Mask nya 

berdasarkan batas wilayah 

(Kabupaten). 

4) Selanjutnya buat kemiringan 

lerengnya dengan masuk ke 

ArcToolbox, pilih 3D Analyst 

Tools > Raster Surface > Slope. 

Sehingga akan terbentuk Raster 

baru dengan tampilan 

berdasarkan kemringan lereng. 

Akan tetapi kelas lereng tersebut 

belum sesuai dengan yang 

diinginkan, oleh karena itu 

berikan kelas sesuai yang di 

inginkan dengan mengunakan 

pedoman yang sudah ada. 

5) Cara untuk menentukan kelas 

kemiringan tersebut, masuk ke 

Properties (kelik kanan hasil dari 

slope) > Symbology > Classified 

> Classify. Atau dengan cara lain 

masuk ke ArcToolbox pilih 

Spatial Analyst Tools > Reclass > 

Reclassify. Tentukan jumlah 

kelas yang di inginkan yakni 5 

kelas, lalu masukan persentase 

kelas. 

2. Jenis Tanah 

 

Gambar 2. Model Pemetaan Jenis 

Tanah 

1) Masukan data SHP jenis tanah 

Kalimantan Barat yang telah di 

download /unduh dari INA 

Geospasial dengan cara Add 

Data. 

2) Kemudian potong data SHP jenis 

tanah Kalimantan barat dengan 

cara masuk ke ArcToolbox, 

kemudian pilih Analysis Tools > 

Extract > Clip. 

3) Gabungkan data menjadi satu 

dengan Dissolve, caranya masuk 

ke ArcTolbox, kemudian pilih 

Data Mangement Tools > 

Generalization > Dissolve. 

4) Cara untuk menentukan kelas 

kemiringan tersebut, masuk ke 

Properties (kelik kanan hasil dari 

slope) > Symbology > Classified 

> Classify. Atau dengan cara lain 

masuk ke ArcToolbox pilih 

Spatial Analyst Tools > Reclass > 

Reclassify. Tentukan jumlah 

kelas yang di inginkan yakni 5 

kelas, lalu masukan persentase 

kelas. 
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3. Sungai 

 
Gambar 3. Model Pemetaan Jarak 

Sungai 

1) Potong Dem dengan area 

pemotong, caranya masuk ke 

ArcToolbox, kemudian pilih 

Spatial Analyst Tools > 

Extraction > Extract By Mask. 

Lalu tentukan raster yang akan di 

potong dan area  pemotongnya. 

2) Ubah data DEM. Maka harus di 

konversi dari koordinat WGS 

kedalam UTM, caranya 

ArcToolbox > Data Managemen 

Tool > Projection and 

Transformation > Raster > Raster 

Project. 

3) DEM yang sudah di potong 

apabila mengunakan data kontur 

tersebut harus di konversi terlebih 

dahulu menjadi format raster 

dengan cara masuk ke 

ArcToolbox, pilih 3D Analyst 

Tools > Raster Interpolation > 

Topo to Raster. 

Masih dalam Tools ini juga 

setting Enviromentts nya, bagian 

Processing Extent atur Snap 

Raster berdasarkan batas wilayah 

(Kabupaten) dan bagian Raster 

analysis atur Mask nya 

berdasarkan batas wilayah 

(Kabupaten). 

4) Selanjutnya buat Fill dengan cara 

masuk ke ArcToolbox, pilih 

Spatial Analys Tool > Hydrology 

> Fill. 

5) Selanjutnya buat Flow Direction 

dengan cara masuk ke 

ArcToolbox, pilih Spatial Analys 

Tool > Hydrology > Flow 

Direction. 

6) Selanjutnya Flow Accmulation 

dengan cara masuk ke 

ArcToolbox, pilih Spatial Analys 

Tool > Hydrology > Flow 

Accmulation. 

7) Selanjutnya Raster Calculator 

dengan cara masuk ke 

ArcToolbox, pilih Spatial Analys 

Tool > Map Algebra > Raster 

Calculator. 

8) Selanjutnya Stream Order dengan 

cara masuk ke ArcToolbox, pilih 

Spatial Analys Tool > Hydrology 

> Stream Order. 

9) Selanjutnya Stream to Feature 

dengan cara masuk ke 

ArcToolbox, pilih Spatial Analys 

Tool > Hydrology > Stream to 

Feature. 

10) Selanjutnya Line Density dengan 

cara masuk ke ArcToolbox, pilih 

Spatial Analys Tool > Density > 

Line Density. 

11) Selanjutnya buat kelas jarak 

sungai tersebut, masuk ke 

Properties (kelik kanan hasil dari 

Line Density) > Symbology > 

Classified > Classify. Atau 

dengan cara lain masuk ke 

ArcToolbox pilih Spatial Analyst 

Tools > Reclass > Reclassify. 

Tentukan jumlah kelas yang di 

inginkan yakni 5 kelas, lalu 

masukan persentase kelas. 
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4. Penggunaan Lahan 

 
Gambar 4. Model Pemetaan 

Penggunaan Lahan 

1) Masukan data SHP jenis tanah 

Kalimantan Barat yang telah di 

download /unduh dari INA 

Geospasial dengan cara Add 

Data. 

2) Kemudian potong data SHP jenis 

tanah Kalimantan barat dengan 

cara masuk ke ArcToolbox, 

kemudian pilih Analysis Tools > 

Extract > Clip. 

3) Gabungkan data menjadi satu 

dengan Dissolve, caranya masuk 

ke ArcTolbox, kemudian pilih 

Data Mangement Tools > 

Generalization > Dissolve. 

4) Selanjutnya buat kelas pengunaan 

lahan tersebut, masuk ke 

Properties (kelik kanan hasil dari 

Disolve) > Symbology > 

Classified > Classify. Atau 

dengan cara lain masuk ke 

ArcToolbox pilih Spatial Analyst 

Tools > Reclass > Reclassify. 

Tentukan jumlah kelas yang di 

inginkan yakni 5 kelas, lalu 

masukan persentase kelas. 

 

 

 

 

 

 

5. Tingkat Kerawanan Kebakaran 

Hutan Dan Lahan 

 
Gambar 5. Model Pemetaan Tingkat 

Kerawanan Kebakaran Hutan dan 

Lahan 

1) Masukan semua data yang sudah 

di olah dengan cara Add Data 

a) Kemiringan lereng 

b) Jenis tanah 

c) Sungai 

d) Pengunaan lahan 

2) Gabung semua peta menjadi satu 

dengan cara masuk ke ArcTolbox 

pilih Spatial Analyst Tools > 

Overlay > Weight Zum. 

3) Selanjutnya buat kelas tingkat 

kerawanan kebakaran hutan dan 

lahan tersebut, masuk ke 

Properties (klik kanan hasil Weigt 

Zum) > Symbology > Classified > 

Classify. Atau dengan cara lain 

masuk ke ArcToolbox pilih 

Spatial Analyst Tools > Reclass > 

Reclassify. Tentukan jumlah 

kelas yang di inginkan yakni 5 

kelas, lalu masukan persentase 

kelas. 
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b. Tingkat Kerawanan Kebakaran 

Hutan Dan Lahan 

1. Kemiringan Lereng 

 
Gambar 6. Peta Kemiringan Lereng 

1) 0 – 8 % 

2) 8 – 15 % 

3) 15 – 25 % 

4) 25 – 45 % 

5) > 45 % 

2. Jenis Tanah 

 
Gambar 7. Peta Jenis Tanah 

1) Badan Air, Sungai, Danau 

2) Escarpment, Gawir 

3) Gosong Pasir 

4) Histosol 

5) Inceptisol 

6) Oxisol 

7) Penambangan, Tanah Terbuka 

8) Spodosol 

9) Ultisol 

 

 

 

 

3. Sungai 

 
Gambar 8. Peta Jarak Sungai 

1) 0 – 2 KM 

2) 2 – 4 KM 

3) 4 – 6 KM 

4) 6 – 8 KM 

5) 8 – 10 KM 

4. Penggunaan Lahan 

 
Gambar 9. Peta Penggunaan Lahan 

1) Bandara, Pelabuhan 

2) Belukar 

3) Belukar Rawa 

4) Hutan Lahan Kering Primer 

5) Hutan Lahan Kering Sekunder 

6) Hutan Rawa Primer 

7) Hutan Rawa Sekunder 

8) Pemukiman 

9) Perkebunan 

10) Pertambangan 

11) Pertanian Lahan Kering 

12) Pertanian lahan Kering Campur 

13) Tanah Terbuka 

 

 



Vol.2 No.2 Agustus 2022 Geo Khatulistiwa: Jurnal Pendidikan Geografi dan Pariwisata   ISSN:2808-2974 
 

40 
 

5. Tingkat Kerawanan Kebakaran 

Hutan Dan Lahan 

 
Gambar 10. Peta Tingkat 

Kerawanan Kebakaran Hutan Dan 

Lahan 

1) Sangat Tidak Mudah 

2) Tidak Mudah 

3) Sedang 

4) Mudah 

5) Sangat Mudah 

Pembahasan 

Model Pemetaan Tingkat Kerawanan 

Kebakaran Hutan Dan Lahan 

Jadi ketika kita ingin membuat 

pemetaan tingkat kerawananan 

kebakaran hutan dan lahan dengan 

parameter kemiringan lereng, jenis tanah, 

sungai, dan penggunaan lahan yang sama 

tidak perlu membuatnya secara manual 

lagi cukup dengan memangil model 

builder yang telah kita simpan 

sebelumnya dan secara otomatis akan 

membuat peta secara berurutan sesuai 

dengan model yang telah kita buat 

sebelumnya sehinga akan menjadi peta 

sesuai keinginan kita yang telah kita buat 

pada model builder tersebut. 

Tingkat Kerawanan Kebakaran Hutan 

Dan Lahan 

1. Kemiringan Lereng 

Pada peta ini yang di 

perhatikan adalah interaksi nya 

dengan manusia, dimana manusia 

adalah penyebab utama dari 

kebakaran hutan dan lahan di 

bandingkan interaksi dengan faktor 

alam. 

Jadi dapat disimpulkan bahwa 

diderah Kabupaten Kapuas Hulu 

tingkat kerawanan kebakaran hutan 

dan lahan menurut peta kemiringan 

lereng sangat tinggi di kecamatan 

Emapanang, Badau, Batang Lupar, 

Semitau, Suhaid, Selimbau, 

Jongkong, Bunut Hilir, Embaloh 

Hilir, Bika, Boyan Tanjung, 

Pengkadan, Seberuang, Silat Hilir, 

Puring Kencana. Itu diakibat kan 

karena daerah di daerah tersebut 

memiliki tingkat kemiringan lereng di 

bawah 8 % dan tingkat kerawanan 

tinggi, sedang, mudah dan tidak 

mudah terdapat pada daerah Silat 

Hulu, Hulu Gurung, Bunut Hulu, 

Mentebah, Kalis, Putusibau Selatan, 

Putusibau Utara, dan Embaloh Hulu. 

2. Jenis Tanah 

Diantara jenis – jenis tanah 

diatas memiliki tingkat kerawanan 

kebakaran yang berbeda – beda 

karena setiap jenis tanah memiliki 

karakteristik dan teksur yang tidak 

sama. Tekstur tanah adalah keadaan 

tanah yang menunjukan kasar halus 

nya tanah sedangkan karakteristik 

tanah adalah ciri – ciri dari tanah 

tersebut. 

Jadi dapat disimpulkan bahwa 

diderah Kabupaten Kapuas Hulu 

tingkat kerawanan kebakaran hutan 

dan lahan menurut peta jenis tanah 

tidak mudah terbakar. Itu diakibatkan 

karena hampir semua daerah di 

Kabupaten Kapuas Hulu memiliki 

jenis tanah oxisol dan ultisol dimana 

jenis tanah tersebut masih di dalam 

kategori tidak mudah dan sedang. 

3. Sungai 

Jarak sungai ini berguna 

untuk menentukan tingkat kerawanan 

kebakaran hutan dan lahan dimana 
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semakin dengan sungai maka 

semakin tidak mudah terjadi nya 

suara kebakaran di daerah tersebut. 

Begitupun sebalik nya jika jarak 

sungai semakin jauh maka akan 

semakin mudah juga terjadinya suatu 

kebakaran hutan dan lahan di daerah 

tersebut. 

Jadi dapat disimpulkan bahwa 

diderah Kabupaten Kapuas Hulu 

tingkat kerawanan kebakaran hutan 

dan lahan menurut peta jarak sungai 

tidak mudah terbakar. Itu diakibatkan 

karena hampir semua daerah di 

kabupaten dekat dengan sungai dan 

jarak yang jauh dari sungai pun tetap 

ada sungai yang mengitari daerah 

tersebut. 

4. Penggunaan Lahan 

Diantara jenis pengunaan 

lahan diatas memiliki tingkat 

kerawanan kebakaran yang berbeda – 

beda karena setiap lahan memiliki 

karakteristik yang berbeda – beda 

antar satu dengan yang lain. Dimana 

pengunaan lahan ini adalah segala 

campur tangan manusia, baik secara 

permanen maupun secara siklus 

terhadap suatu kelompok sumber 

daya alam dan sumber daya buatan 

secara keseluruhan disebut lahan, 

dengan tujuan untuk mencukupi 

kebutuhan – kebutuhan nya baik 

secara kebendaan maupun spiritual 

atau dua – dua nya. 

Jadi dapat disimpulkan bahwa 

diderah Kabupaten Kapuas Hulu 

tingkat kerawanan kebakaran hutan 

dan lahan menurut peta pengunaan 

lahan mudah terbakar. Itu diakibatkan 

karena hampir semua daerah di 

Kabupaten Kapuas Hulu penggunaan 

lahan nya adalah hutan lahan kering 

primer, pertanian lahan kering 

campur, hutan rawa sekunder, hutan 

lahan kering sekunder, tanah terbuka 

dan belukar. Dari ke enam 

penggunaan lahan tersebut hanya ada 

satu pengunan lahan yang sangat 

tidak mudah yaitu tanah terbuka. Jadi 

secara keseluruhan menurut 

pengunaan lahan Kabupaten Kapuas 

Hulu tingkat kerawanan nya mudah 

terjadinya kebakaran. 

5. Tingkat Kerawanan Kebakaran 

Hutan Dan Lahan 

Pada peta tingkat kerawanan 

kebakaran hutan dan lahan ini 

merupakan gabungan dari empat peta 

yang berbeda kemudian di gabungkan 

atau di satukan menjadi satu peta 

yaitu peta tingkat kerawanan 

kebakaran hutan dan lahan, dimana 

ke empat peta tersebut adalah peta 

kemiringan lereng, peta jenis tanah, 

peta jarak sungai dan peta 

penggunaan lahan. Proses 

penggabungan ke empat peta tersebut 

mengunakan weighted zum dengan 

cara memasukan ke empat peta 

tersebut dengan memberikan setiap 

peta bobotan berimbang dan setelah 

semua prosesnya selesai akan 

didapatkan sebuah peta tingkat 

kerawanan kebakaran hutan dan 

lahan. 

Pada peta diatas dengan 

tingkat kerawanan kebakaran hutan 

dan lahan sedang adalah paling 

banyak yang dimiliki kapuas hulu, 

kemudian yang kedua adalah dengan 

tingkat kerawanan kebakaran hutan 

dan lahan yang mudah. Kemudian 

disusul tingkat kerawanan tidak 

mudah dan mudah, serta yang paling 

terakhir adalah tingkat kerawanan 

kebakaran hutan dan lahan sangat 

muda. 

Jadi dapat disimpulkan bahwa 

diderah Kabupaten Kapuas Hulu 

tingkat kerawanan kebakaran hutan 

dan lahan mudah terbakar. Itu 
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diakibatkan karena hampir semua 

daerah memiliki klasifikasi mudah 

terbakar dan sedang. 
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